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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2008 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

For additional trademark information, see Chapter 9, “Copyright,” in the Reference Guide.  
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport  

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Enterprise Discovery 

Release Notes 
Software version: 2.22 / January 2008 

This document provides an overview of the changes made to Enterprise Discovery for version 2.22. It 
contains important information not included in the manuals or in the online help. 

In This Version

New Features

Obsolete Features 

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.22. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.2x, 2.1.x and 2.0.x. 

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.0, 2.0.1, 2.0.2, 2.0.3, 2.0.4, 2.1, 2.1.1, 2.1.2, 2.1.3, 2.20, and 2.21), you can read the 
Release Notes for those versions, available on your installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data from a maximum of 50,000 inventoried devices and 60,000 
devices in total. The port limit is 150,000 ports (whichever comes first). An Enterprise Discovery Aggregator 
can support 50 servers and up to 500,000 devices. 

The new Automated Inventory license enables you to purchase inventory capability based on the number of 
devices that you expect to manage. This license replaces the Device Discovery and Device Inventory licenses 
provided in previous versions of Enterprise Discovery. If you have purchased these two licenses for a 
previous version, you will have access to all features provided with the Automated Inventory license offered 
with version 2.22. Note that the Automated Inventory license is functional but is not yet reflected in the 
Enterprise Discovery user interface. 

Updated third party components 

• Sun Java Runtime Environment (JRE) 1.5.0_14 

• OpenSSL 0.9.8g 
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New Features  
There are no new features in this release. This release contains bug fixes only. 
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Obsolete Features 
All features in 2.21 are supported in release 2.22. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals/ 

1 Uncheck Show only my products if checked. 

2 In the Product list, click the product name (for example, Enterprise Discovery). 

3 In the Version list, click the version number. 

4 In the OS list, click the operating system type. 

5 Click Search. A document list is displayed that matches your search criteria. 

6 In the document list, click the document title. The document opens in your browser window. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

• Migrating from Network Discovery 

None of these guides have been reissued for release 2.22. 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 
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Installation Notes 
Installation requirements, as well as instructions for installing Enterprise Discovery, are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery.   

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.0.x: C:\Program Files\Peregrine\Enterprise Discovery\2.0.* 

Version 2.1.x: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

Version 2.2x: C:\Program Files\HP OpenView\Enterprise Discovery\2.2x 

4 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

5 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server, Service Pack 1 or Service Pack 2. 
The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB under Program Files 
for the Enterprise Discovery installation. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A
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on
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ed
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to
ry

 

T
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Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x 3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  2 
2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x   5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000 
 

x x 7 
2+ CPUs or cores 
3.6 GHz 260 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

* CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP Enterprise Discovery consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs and more memory may be required. 
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Enterprise Discovery routinely performs many disk access operations. In order to improve 
performance, especially for networks with a large number of devices, it is recommended that you 
use fast access disks such as SCSI. 
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These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client installation has the following requirements: 

Operating System Windows 2000, XP, or 2003 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

5.0 or 6.0 
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Enhancements and Fixes 
This release contains bug fixes only. The following items (identified by error tracking number) were fixed in 
the current software release. 

Table 2 - Problems Fixed 

Number Location Fix Description 

17606 Mac OS X Agent When the Mac OS X agent is running, using the agent 
installation disk image to upgrade an existing agent now 
commits the changes immediately. 

18015 Linux Scanner Virtual network interfaces are now included in the scan file. 

18292 Windows Scanner Detection of device driver files on Windows has been fixed. 
The files now have the correct device drive attribute D 
included as part of their file attributes. 

18325 Network Map The problem that caused the “Network Map Disconnect Error” 
to occur in some cases has been fixed. 

18331 Aggregator The consistency check mechanism now works when 
performing high volume delete operations. 

18344 Topology Engine The Topology Engine no longer crashes while processing the 
time string with an invalid time value. 

18388 Scanners The problem that caused Extract Options to not be applied to 
the registry and environment extract asset fields in some 
cases has been fixed. 

18398 UNIX Scanner NFS mount network drives are now detected correctly and are 
not scanned. 

18406 System Monitor The problem that caused Enterprise Discovery Server services 
to fail to start on rare occasions has been fixed. 

18408 Scanners The delta scan file is now returned when delta scanning is 
enabled. 

18412 Scheduler The Aggregate database tables are now periodically 
optimized. 

18430 Aggregator Duplicate IP and MAC addresses that belong to the same 
device in the Discovery database no longer cause Inventory 
import into the Aggregate database to abort. 

18433 Discovery Engine Scanner merging logic has been improved. The Device ID in 
the scanner merging logic is now optional and can be removed 
from the merging list if desired. 

18436 Reports MTTR and MTBF reporting thresholds are now working 
correctly when set to the default values. 
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Number Location Fix Description 

18508 Topology Converter The Topology Converter no longer crashes. 

18510 Administration > 
Event Filter 
Configuration 

The changes made to the State Transition fields when 
modifying the Event Filter Configuration now persist. 

18557 Server Performance has been improved around database connections. 

18561 Event Manager Events are no longer listed with the erroneous future 
timestamps. 

18590 Scanners The scanner no longer fails when scanning a directory with a 
% somewhere in its name. 
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Known Problems, Limitations, and Workarounds 

Agents 

• The agent upgrade process on Solaris 9 may take a long time (SCR# 16663).  

• MAC OS X agent upgrade may not work when initial agent was installed and run from shell (SCR# 
16828).  

Scanners 

• In Manual Deployment Mode, the UNIX scanner will not save offsite scan files to an FTP server when 
the user name is specified in the form domain name/user name (SCR# 12893).  

• Automounts are being scanned in HP-UX and Linux systems (SCR# 15950). 

• Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

• On some Linux distributions, the scanner does not collect Graphics Data (SCR# 17523). 

• When a user is connected to a machine through terminal session, the scanner launched in the manual 
deployment mode gets data related to the session rather than the actual video card data (SCR# 17528). 

• Video card and video memory are not detected properly if the user is logged in to a terminal session 
(SCR# 17528). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (SCR# 15827). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

Server Installation 

• After an uninstall, the branding registry keys are leftover (SCR# 15507).  

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370).  

• Enterprise Discovery with a Network Topology license should not be installed on VMware (SCR# 16524). 

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(SCR# 16520 and SCR# 17016).  

Server 

• If your server has another service using port 80, the HP OpenView Discovery Apache service will not run 
properly (SCR# 14808).  
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• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (SCR# 13964).  

• An older openssl DLLs in the system PATH can affect the Enterprise Discovery Apache server and perl 
engines (SCR# 16318). 

• With the Alarms license only if the configuration option “Number of days to keep imported Discovery 
Database files” (under Administration > System Configuration > Aggregate Configuration) is set to a 
value lower than 10 days, some scheduled tasks will run more frequently than they should and could 
overload the server (SCR# 17459). 

• The VMware discovery user action does not generate an access event and, as a result, the information is 
not reported to the audit log (SCR# 17642). 

• In some cases, devices are incorrectly deactivated with the “License exceeded” reason (SCR# 18195). 

• In some cases, the event notification delays configured in filters are not taken into account and extra 
event notifications are generated (SCR# 18528). 

Web User Interface 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" option in Discovery Configuration may 
not have any effect (SCR# 14388). 

• First time accessing a screen under Administration > Discovery Configuration might be slow (SCR# 
17312).  

• In the Discovery Configuration, the Subnet IP Type condition should not allow duplication in equivalent 
netmask values (SCR# 17407). 

• In the Discovery Configuration, moving credentials up and down in newly added SNMP and 
Virtualization configuration profiles will not be taken into account. As a workaround, first save the 
profile and then edit it (SCR# 17590). 

• The Device Groups main screen of the Discovery Configuration does not allow sorting by priority (SCR# 
17484).  

• The browser back button loses the correct navigational path when used with the Discovery Configuration 
(SCR# 17491).  

• For a system-defined Virtualization Profile of the Discovery Configuration, the Associated Groups tables 
do not sort (SCR# 17514). 

• In the Discovery Configuration, disabling the "VMware discovery interval" property under the 
Virtualization Configuration Profile is not possible without explicitly entering the value 0 (SCR# 17626). 

Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (SCR# 13803).  

Web Asset Questionnaire 

• The UI may show non-printable characters in text fields (SCR# 16285).  
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Applets 

• Aggregate Find > UpdateModel > Run VMware Discovery can not be disabled when the Device is not 
configured for VMware discovery (SCR# 17502).  

• The Network Map “out of memory” error occurs when continually opening and closing the map window. 
It is necessary to close and reopen the browser to initialize the java plug-in (SCR# 17569). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (SCR# 16041). 

Internationalization 

• The Scanner Generator cannot be launched when the product is installed in a directory with non-ASCII 
characters in the path (SCR# 17104). 

• Reports do not use the language options configured in the operating system and will always format the 
dates in English (SCR# 17140).  

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (SCR# 17180). 

• NetBIOS information collected by the network models will be displayed incorrectly if the string has non 
ASCII characters (SCR# 17411). 
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